Package ‘RcmdrPlugin.EZR’

August 31, 2017

Type Package
Title R Commander Plug-in for the EZR (Easy R) Package
Version 1.36
Date 2017-09-01
Author Yoshinobu Kanda
Maintainer Yoshinobu Kanda <ycanda-tky@umin.ac.jp>
Depends R (>= 3.2.0)
Imports Rcmdr (>= 2.4.0)
Suggests abind, aod, aplpack, car, clinfun, cmprsk, foreign, meta,
metatest, multcomp, mvtnorm, optmatch, pROC, survRM2, tableone,
readxl

Description
EZR (Easy R) adds a variety of statistical functions, including survival analyses, ROC analyses,
metaanalyses, sample size calculation, and so on, to the R commander. EZR enables point-
and-click easy access to statistical functions, especially for medical statistics. EZR is platform-
independent and runs on Windows, Mac OS X, and UNIX. Its complete manual is avail-
able only in Japanese (Chugai Igakusha, ISBN: 978-4-498-10901-8 or Nankodo, ISBN: 978-4-
524-26158-1), but an report that introduced the investigation of EZR was published in Bone Mar-
row Transplantation (Nature Publishing Group) as an Open article. This re-
port can be used as a simple manual. It can be freely downloaded from the journal web-
site as shown below. This report has been cited in more than 1,000 scientific articles.

Copyright The functionos in EZR package were programmed by Y. Kanda,
except for the following functions, dot.plot(), prop.conf(),
Cochran.Q.test(), pairwise.prop2.test(),
pairwise.pairedt.test(), pairwise.kruskal.test(),
pairwise.friedman.test(), pairwise.logrank.test(),
pairwise.gray.test(), Steel.Dwass(), Steel(), pdunnet(),
Mantel.Byar() were modified from the corresponding functions
distributed by professor Aoki
(http://aoki2.si.gunma-u.ac.jp/R). crr() and cuminc() were
derived from cmprsk package. nrisk() was modified from survplot
documentation (http://www.cbs.dtu.dk/~eklund/survplot/). epi.test()
and epi.kappa() were derived from epiR package.
jonckheere.test(), ph2simon() and ph2single() were derived from clinfun package. Functions of meta-analysis were derived from meta and metatest packages. Functions of matched-pair analysis were derived from optmatch package, and its license restricts to academic use. See http://cran.r-project.org/web/packages/optmatch/LICENSE for details. The package must be installed before performing matched-pair analysis, assuming the user is covered by the license. Functions of receiver-operating characteristics curve analyses were derived from pROC package. Many dialog functions in EZR were modified from the corresponding functions in Rcmdr package and RcmdrPlugin.survivalT package.

License GPL (>= 2)

NeedsCompilation no
Repository CRAN
Date/Publication 2017-08-31 03:29:56 UTC

R topics documented:

EZR ...................................................... 2
EZR dialogs ............................................. 8
hist2 ................................................... 9
HistEZR ............................................... 10
ifelse2 ............................................... 11
Mantel.Byar ......................................... 11
rmean.table ........................................ 12
w.multi .............................................. 13

Index 15

EZR

Rcmdr Plug-In Package for the EZR (Easy R especially for medical statistics)

Description

This package provides an R Commander plug-in EZR (Easy R), which adds a variety of statistical functions, including survival analyses, ROC analyses, metaanalyses, sample size calculation, and so on, to the R commander. EZR enables point-and-click easy access to a variety of statistical functions as shown below, especially for medical statistics. A report that introduced the investigation of EZR was published in Bone Marrow Transplantation (Nature Publishing Group) as an Open article. This report can be used as a simple manual. It can be freely downloaded from the journal website (URL: http://www.nature.com/bmt/journal/vaop/ncurrent/pdf/bmt2012244a.pdf). A

Details

Package: RcmdrPlugin.EZR
Type: Package
Version: 1.36
Date: 2017-09-01
License: GPL (>= 2)

Installation of EZR

See http://www.jichi.ac.jp/saitama-sct/SaitamaHP.files/statmedEN.html for detailed information. Briefly, EZR is platform-independent. RcmdrPlugin.EZR should be installed with R commander (Rcmdr) and the other packages that Rcmdr or EZR depends on. Packages required by EZR can be easily installed at the same time with the installation of EZR by copying and pasting the following command to the R console window after "">

install.packages(pkgs="RcmdrPlugin.EZR", dependencies=TRUE)

After installation, R commander can be started by the command, library(Rcmdr) from the R console. Packages required by Rcmdr are installed at the first start-up of R commander. EZR can be loaded by selecting RcmdrPlugin.EZR from the "Tools" > "Load Rcmdr plug-in(s)" menu. Answer "Yes" to "Restart now?".

On Windows, EZR plugin package will be loaded when R commander is started, if the following sentence is added to the Rprofile.site file in etc folder in the R folder (C:\Program Files\R\R-XX.X\etc).

options(Rcmdr=list(plugins="RcmdrPlugin.EZR"))

In addition, if the following phrase is added to the command in "Target:" column on the "Shortcut" tab of the "Property" of "R" shortcut on the desktop (which can be opened by right-clicking on the shortcut), R commander will start at the same time with launching R.

R_DEFAULT_PACKAGES="Rcmdr"

Therefore, if these two options were added, EZR can be started just by double-clicking on the "R" shortcut on the desktop.

In OS X, these can be done by opening the Terminal.app located in the Utilities folder, followed by copying and pasting the following command.
The default data folder of Windows EZR can be changed by right-clicking on this "R" shortcut on the desktop, selecting "Properties", and replacing the folder name in the "Start in:" column on the "Shortcut" tab.

**EZR statistical functions**

EZR includes following statistical functions.

*For discrete variables*

- Frequency distributions
- Confidence interval for a proportion
- One sample proportion test
- Confidence interval for a difference between two proportions
- Confidence interval for a ratio of two proportions
- Compare two proportions (Fisher’s exact test and Chi-square test)
- Compare proportions of two paired samples (McNemar test)
- Compare proportions of more than two paired samples (Cochran Q test)
- Cochran-Armitage test for trend in proportions
- Logistic regression

*For continuous variables*

- Numerical summaries
- Smirnov-Grubbs test for outliers
- Kolmogorov-Smirnov test for normal distribution
- Confidence interval for a mean
- Single-sample t-test
- Two-variances F-test
- Two-sample t-test
- Paired t-test
- Bartlett’s test
- One-way ANOVA
- Repeated-measures ANOVA
- Multi-way ANOVA
- ANCOVA
- Test for Pearson’s correlation
- Linear regression

*For nonparametric tests for continuous variables*
Mann-Whitney U test
Wilcoxon’s signed rank test
Kruskal-Wallis test
Friedman test
Jonckheere-Terpstra test
Spearman’s rank correlation test

For survival analysis
Kaplan-Meier survival curve and logrank test
Logrank trend test
Cox proportional hazard regression
Cox proportional hazard regression with time-dependent covariate
Cumulative incidence of competing events and Gray test
Fine-Gray proportional hazard regression for competing events

For diagnostic test analysis
Accuracy of qualitative test
Kappa statistics for agreement of two tests
Compute positive and negative predictive values
ROC curve analysis for quantitative test
Compare two ROC curves
Cronbach’s alpha coefficient for reliability

For matched-pair analysis
Extract matched controls (This function relies on optmatch package and is limited to academic use.)
Mantel-Haenszel test for matched proportions
Conditional logistic regression for matched-pair analysis
Stratified Cox proportional hazard regression for matched-pair analysis

For meta-analysis and meta-regression test
Meta-analysis and meta-regression test for proportions
Meta-analysis and meta-regression test for means
Meta-analysis and meta-regression test for hazard ratios

For sample size and power calculation
Calculate sample size from control and desired response rates
Calculate sample size from proportion and confidence interval
Calculate sample size or power for comparison with specified proportion
Calculate sample size or power for comparison between two proportions
Calculate sample size for non-inferiority trial of two proportions
Calculate sample size from standard deviation and confidence interval
Calculate sample size or power for comparison between two means
Calculate sample size for non-inferiority trial of two means
Calculate sample size or power for comparison between two paired means
Calculate sample size or power for comparison between two survival curves
Calculate sample size for non-inferiority trial of two survival curves

For drawing graphs

Bar graph(Frequencies)
Pie chart(Frequencies)
Stem-and-leaf display
Histogram
QQ plot
Bar graph(Means)
Line graph(Means)
Line graph(Repeated measures)
Boxplot
Dot chart
Ordered chart
Scatterplot
Scatterplot matrix
Adjusted survival curve
Stacked cumulative incidences

Statistical functions from original R commander

Principal-components analysis
Factor analysis
k-means cluster analysis
Hierarchical cluster analysis
Summarize hierarchical clustering
Add hierarchical clustering to data set
Linear hypothesis
Variance-inflation factor
Breusch-Pagan test for heteroscedasticity
Durbin-Watson test for autocorrelation
RESET test for nonlinearity
Bonferroni outlier test
Basic diagnostic plots
Residual quantile-comparison plot
Component+residual plots
Added-variable plots
Influence plot
Effect plots
Basic operations in EZR

These EZR functions can be started by point-and-click access using the items on the menu bar. See EZRdialog for details. R commander automatically creates and executes corresponding R commands that appear in the "Script window". Results are shown in the "Output window". If any errors or warnings are noted, messages will appear in the "Message window". The created commands can be saved by selecting "File" > "Save script" on the menu bar. The output can be saved by selecting "File" > "Save output". By saving the commands, users can reproduce the analyses and can also share the procedure with the other investigators.

The following EZR functions can be executed by typing the commands in the "Script window" and clicking on the "Submit" button.

Following functions are built to create a formatted table for presentation.

- `w.twoway(table, filename)` function copies the results of two-way table analyses to the clipboard or text file.
- `w.ttest(table, filename)` function copies the results of t-test to the clipboard or text file.
- `w.survival(table, filename)` function copies the results of survival analyses to the clipboard or text file.
- `w.ci(table, filename)` function copies the results of cumulative incidence analyses to the clipboard or text file.
- `w.multi(table, filename)` function copies the results of multivariate regression analyses to the clipboard or text file.

"table" can be omitted except for logistic regression analysis and Fine & Gray proportional hazard regression analysis, in which "odds" and "crr.table" should be specified for "table" (default is "cox.table" to copy the results of Cox proportional hazard regression analysis). If "filename" is omitted, the formatted table will be copied to the clipboard, which can be pasted into a spreadsheet.

- `Mantel.Byar()` function is for Mantel-Byar test and Simon and Makuch plot, which should be performed after executing "Cox proportional hazard modeling with time-dependent covariate".
- `rmean.table()` function is for restricted mean survival time analysis, that should be used after "Kaplan-Meier survival curve and logrank test" analysis.
- `rmean.table.adjusted()` function is for adjusted restricted mean survival time analysis, that should be used after "Adjusted survival curve" analysis.

Translations

EZR comes with translations from English into Japanese.
EZR dialogs

Description

EZR dialogs enable point-and-click easy access to a variety of statistical functions.

Details

EZR dialogs enable point-and-click easy access to a variety of statistical functions.

To select more than one variable in the list box, click on variables pressing Ctrl key, and to deselect one of the selected variables, click on the variable to deselect pressing Ctrl key.

To perform analyses in a subset of the samples, type an R expression into the box labelled "Condition to limit samples for analysis". For example, to perform analysis in male patients aged at least 60 years old, type `Age >= 60 & Sex == "Male"` into the box, assuming that Age and Sex variables indicate age and sex of the patients, respectively.

Cautions in multivariate analyses using EZR

When a categorical variable with more than two categories is to be analyzed in Fine and Gray regression modeling, dummy variables should be created before an analysis, although such dummy variables are automatically created in multiple regression, logistic regression and Cox proportional
hazards regression in R. For example, if a user wants to evaluate the effect of three types (A, B, and C) of treatments, information for which is included in the categorical variable \( Tx \) as "A", "B" and "C", they would select "Active data set" > "Variables" > "Create dummy variables" from the EZR menu to make three categorical variables named \( \text{Tx.Dummy.A} \), \( \text{Tx.Dummy.B} \), and \( \text{Tx.Dummy.C} \).

\( \text{Tx.Dummy.A} \) has a value of 1 for patients who received treatment A and 0 for others. Users should choose one of the three categories as a reference and input dummy variables for the other two categories into the regression model.

The stepwise selection function of explanatory variables based on Akaike information criterion and Bayesian information criterion only accepts dummy variables automatically created by R, whereas stepwise selection based on P-value also accepts dummy variables created by a user using EZR. If the option for a "Wald test for overall P-value for factors with >2 levels" is selected in the dialog of the regression analyses, the overall P-value for the categorical variable will be calculated.

Survival curves adjusted for other factors by the mean of covariates method, in which average values of covariates are entered into the Cox proportional hazards model, can be drawn by selecting "Graphs" > "Adjusted survival curve".

References

Read following article for details. It can be freely downloaded from the journal website as shown below.


---

```r
hist2

Modified version of hist()
```

**Description**

The modified points from the original `hist()` are 1) `hist2()` uses Scott algorithm instead of Sturges. 2) `hist2()` adds a group below the lowest group created by `hist()`.

**Usage**

```r
hist2(x, breaks="scott", plot=TRUE, ...)
```

**Arguments**

- `x` a vector of values for which the histogram is desired.
- `breaks` see `hist()` for details.
plot logical. If TRUE (default), a histogram is plotted.
... further arguments and graphical parameters passed to plot.histogram and thence to title and axis (if plot = TRUE).

Details
See hist() for details.

See Also
hist

HistEZR **Plot a Histogram**

Description
This function is a wrapper for the hist function in the base package, permitting percentage scaling of the vertical axis in addition to frequency and density scaling. This function is modified from the Hist() function in the Rcmdr package. HistEZR() package in RcmdrPlugin.EZR uses hist2() instead of hist(). In hist2(), the method to set breakpoints between histogram cells was changed from "Sturges" to "Scott".

Usage
HistEZR(x, scale=c("frequency", "percent", "density"), xlab=deparse(substitute(x)), ylab=scale, main="", ...)  

Arguments
  x a vector of values for which a histogram is to be plotted.
  scale the scaling of the vertical axis: "frequency" (the default), "percent", or "density".
  xlab x-axis label, defaults to name of variable.
  ylab y-axis label, defaults to value of scale.
  main main title for graph, defaults to empty.
  ... arguments to be passed to hist.

Value
This function returns NULL, and is called for its side effect — plotting a histogram.

See Also
hist
ifelse2

Examples

```r
data(Prestige, package="car")
HistEZ(R(Prestige$income, scale="percent"))
```

ifelse2  

Conditional Element Selection

Description

ifelse2 returns a value with the same shape as test which is filled with elements selected from either yes or no depending on whether the element of test is TRUE or FALSE. Modified from ifelse.

Usage

```r
ifelse2(test, yes, no)
```

Arguments

test  
an object which can be coerced to logical mode.

yes  
return values for true elements of test.

no  
return values for false elements of test.

Details

The only difference from ifelse is that, when missing values in test, ifelse gives missing values in the result, whereas ifelse2 gives values for false elements of test.

See Also

ifelse

mantel-Byar

mantel-Byar test

Description

Performs Mantel-Byar test for comparison of survival data with a time-dependent covariate.

Usage

```r
Mantel.Byar(  
Group = TempTD$covariate_td, Event = TempTD$endpoint_td,  
StartTime = TempTD$start_td, StopTime = TempTD$stop_td,  
method = c("SAS", "Tominaga"), plot=0, landmark=0)
```
Arguments

- **Group**: Time-dependent covariate.
- **Event**: a vector for event.
- **StartTime**: a vector for starting time.
- **StopTime**: a vector for stopping time.
- **method**: method for analysis. "SAS" or "Tominaga"
- **plot**: plot=1, 2, or 3 to plot Simon and Makuch survival curves. Line discrimination with colors (plot=1), line types (plot=2), or width (plot=3).
- **landmark**: landmark for Simon and Makuch plot.

Details

Performs Mantel-Byar test for comparison of survival data with a time-dependent covariate. This function should be performed after executing "Cox proportional hazard modeling with time-dependent covariate" from the EZR menu. If plot is set to 1, Simon and Makuch plot is drawn with a landmark as specified.

Description

Calculate and compare restricted mean survival.

Usage

```
rmean.table(x=km, tau=NULL)
rmean.table.adjusted(x=coxmodel, tau=NULL)
```

Arguments

- **x**: survfit object
- **tau**: specify a value of the truncation time point for the restricted mean survival calculation, e.g., tau=365. When tau=NULL, the default value (i.e., the minimum of the largest observed "event" time in each of the two groups) is used.

Details

rmean.table() function calculates restricted mean survival with a truncation time point as specified by tau option. Also tests the difference in the restricted mean survival, if there are only two groups. This function should be performed after "Kaplan-Meier survival curve and logrank test" function of EZR (or after executing survfit() command). rmean.table() function does not support stratified analysis. rmean.table.adjusted() function calculates adjusted restricted mean survival. This function should be performed after "Adjusted survival curve" function of EZR.
Create a formatted table for presentation

Description

Creates a formatted table for presentation and outputs to a file or clipboard.

Usage

- `w.multireg(table = multireg.table, filename = "clipboard", CI = 0, signif = 0, en = 1)`
- `w.multi(table = cox.table, filename = "clipboard", CI = 0, signif = 0, en = 1)`
- `w.twoway(table = Fisher.summary.table, filename = "clipboard", en = 1)`
- `w.ttest(table = summary.ttest, filename = "clipboard", en = 1)`
- `w.survival(table = km.summary.table, filename = "clipboard", en = 1)`
- `w.ci(table = ci.summary.table, filename = "clipboard", en = 1)`

Arguments

- **table**: a table to output.
- **filename**: a filename for output. If omitted, a formatted table is copied to the clipboard.
- **CI**: If 0, confidence intervals are shown in parentheses.
- **signif**: Number of significant digits.
- **en**: If 1, create a table in English.

Details

- `w.twoway(table, filename)` function copies the results of two-way table analyses to the clipboard or text file.
- `w.ttest(table, filename)` function copies the results of t-test to the clipboard or text file.
- `w.survival(table, filename)` function copies the results of survival analyses to the clipboard or text file.
- `w.ci(table, filename)` function copies the results of cumulative incidence analyses to the clipboard or text file.
- `w.multireg(table, filename)` function copies the results of multiple regression to the clipboard or text file.
- `w.multi(table, filename)` function copies the results of multivariate regression analyses to the clipboard or text file.

"table" can be omitted except for logistic regression analysis and Fine & Gray proportional hazard regression analysis, in which "odds" and "crr.table" should be specified for "table" (default is "cox.table" to copy the results of Cox proportional hazard regression analysis).
If "filename" is omitted, the formatted table will be copied to the clipboard, which can be pasted into a spreadsheet.

These functions should be performed after executing corresponding analyses from the EZR menu.
Index

*Topic hplot
  HistEZR, 10

*Topic package
  EZR, 2
  hist2, 9
  ifelse2, 11
  Mantel.Byar, 11
  rmean.table, 12
  w.multi, 13

BarplotFor3Factors (EZR), 2

ChrToFactor (EZR), 2
Cochran.Q.test (EZR), 2
crrAIC (EZR), 2
currentFields (EZR), 2

dataframe_print (w.multi), 13
dot.plot (EZR), 2

epi.kappa (EZR), 2
epi.tests (EZR), 2
error.bar (EZR), 2
EZR, 2
EZR dialogs, 8
EZRDdialogs, 7
EZRDdialogs (EZR dialogs), 8
EZRhelp (EZR), 2
EZRVersion (EZR), 2

finaltable_dataframe_print (w.multi), 13

gassign (EZR), 2
get.median.ci (EZR), 2

hist, 10
hist2, 9
HistEZR, 10

ifelse, 11
ifelse2, 11

listCoxModels (EZR), 2
listLMMModels (EZR), 2
logrank.trend (EZR), 2
Mantel.Byar, 11
modelFormulaCox (EZR), 2

nchar.ZenToHan (w.multi), 13
nrisk (EZR), 2
objectCheck (EZR), 2
OrderedPlot (EZR), 2

pairwise.friedman.test (EZR), 2
pairwise.gray.test (EZR), 2
pairwise.kruskal.test (EZR), 2
pairwise.logrank.test (EZR), 2
pairwise.pairedt.test (EZR), 2
pairwise.prop2.test (EZR), 2
par.cex (EZR), 2
par.lwd (EZR), 2
par.option (EZR), 2
p敦nett (EZR), 2
PowerHazard (EZR), 2
PowerMean (EZR), 2
PowerMeanPaired (EZR), 2
PowerProportion (EZR), 2
PowerProportionSingleArm (EZR), 2
print.ci.summary (EZR), 2
prop.conf (EZR), 2
prop.diff.conf (EZR), 2
prop.ratio.conf (EZR), 2

RemoveOutlier (EZR), 2
rmean.table, 12
roc.best (EZR), 2

SampleHazard (EZR), 2
SampleHazardNonInf (EZR), 2
SampleMean (EZR), 2
SampleMeanCI (EZR), 2
<table>
<thead>
<tr>
<th>Function</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SampleMeanNonInf (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SampleMeanPaired (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SamplePhaseII (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SampleProportion (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SampleProportionCI (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SampleProportionNonInf (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>SampleProportionSingleArm (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>skewness.kurtosis (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>stack.cuminc (EZR)</td>
<td>2</td>
</tr>
<tr>
<td>StatMedAdjustedSurvival (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedANCOVA (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedANOVA (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedBarGraph (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedBarMeans (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedBartlett (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedBinVariable (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedBoxPlot (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedChangePalette (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedChToFactor (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLogistic (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCloseCommander (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCloseCommanderAndR (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCochranQ (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCompute (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCopyDataset (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCorrelation (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCountMissing (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCoxRegression (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCoxTD (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCrr (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedCumInc (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedDatediff (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedDeleteVariable (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedDropUnusedFactorLevels (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedDummy (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedEnterTable (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedExportDataSet (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedExportStata (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedFactorToNumeric (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedFilterNA (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedFrequency (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedFriedman (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedFTest (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedGraphOptions (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedGroupsBox (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedHistogram (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedImportExcel (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedImportMinitab (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedImportRDOBCTable (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedImportSPSS (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedImportSTATA (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedJT (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedKaplanMeier (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedKappa (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedKrusWalli (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedKS (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLinearRegression (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLinePlot (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLoadDataSet (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLoadWorkspace (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLog (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLogisticRegression (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedLogrankTrend (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMannW (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMcNemar (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMeanCI (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMergeDatasets (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMeta (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMetaCont (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMetaHazard (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMH (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedModelFormula (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedMultiANOVA (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedNAgroup (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedNewVar (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedNewVar2 (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedNumericalSummaries (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedNumericToFactor (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedOptMatch (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedOrderedChart (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPairedTtest (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPieChart (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPlotMeans (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPlotMeans (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPowerHazard (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPowerMeans (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPowerMeansPaired (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPowerProportions (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPowerProportionsSingle (EZR dialogs)</td>
<td>8</td>
</tr>
<tr>
<td>StatMedPredictiveValue (EZR dialogs)</td>
<td>8</td>
</tr>
</tbody>
</table>